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ABSTRACT 

 

As the Edo State Branch of the Nigerian Institution of Surveyors (NIS) has decided to align with the agency 

(Edo Geographic Information Service) that is responsible for the processing of Certificate of Occupancy to be 

determining positions in the UTM system, the coordinates of the existing controls in the State have to be 

converted to UTM coordinates using conversion software. Consequently, this paper presents detailed 

procedures for the application of AllTrans and Columbus software for positions conversion between NTM and 

UTM systems in Minna datum. The Minna datum properties, as well as the NTM and UTM parameters, have 

been detailed for effective use. The step by step procedures to consider when applying the software have 

enumerated. It was recommended that the Edo State branch of the institution (NIS) should get the full and the 

latest version of the software. It was also recommended that there should be a lecture for the practical 

demonstration of the detailed procedures. 

Keywords: Coordinates, Conversion, NTM, UTM, AllTrans, Columbus, Software, Minna Datum, Clarke 1880 

 

I. INTRODUCTION 

 

The Edo State Government of Nigeria has established 

an agency responsible for the processing of Certificate 

of Occupancy. The agency known as the Edo 

Geographic Information Service uses orthophotos for 

positions determination. The orthophotos were 

georeferenced with Universal Traverse Mercator 

(UTM) coordinates in Minna datum. Thus, the 

positions determined by the agency using the 

orthophotos are in UTM. The system does not have a 

frame to realize it in the State. 

Over the years, positions of points have been 

determined in the State by Surveyors in the Nigeria 

Traverse Mercator, NTM (state plane) which is also 

known as the National Origin. These two systems 

(NTM and UTM) are rectangular coordinate systems 

measured in linear metres. But they are different in 

origin and scale. The processing of a Certificate of 

Occupancy requires the use of a survey plan produced 

by a Registered Surveyor. Presently, Surveyors in the 

State are producing survey plans with respect to the 

National Origin (NTM) while the agency is 

checking/charting the positions determined in NTM 

by the private practising Surveyors using their (the 

agency) system designed to determine positions in 

UTM. Checking/charting the NTM coordinates by the 

agency with its system requires the conversion of the 

NTM positions to UTM coordinates. Consequently, 

the Nigerian Institution of Surveyors, Edo State 

Branch has decided to be determining positions in the 

State in the UTM system to align the agency. To do 

this, the NTM positions of all the existing control 

stations in the State must be converted to UTM 

positions of the same controls. This is necessary as any 
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survey carried out must be connected to as well as 

oriented with not less than three control stations. The 

switching from NTM to UTM position determination 

by the Institution was discussed in its meeting held on 

1st June 2019, but the final decision is yet to be 

conveyed to the respective state surveyors. The 

conversion of positions in a rectangular system (NTM 

or UTM) to another rectangular system (NTM or 

UTM), requires the coordinates to be first converted 

to geographic coordinates then from geographic 

coordinates to the positions of the points in any other 

rectangular coordinate system of interest. Also, from 

the geographic coordinates, the geocentric 

coordinates (XYZ) of the points can be determined. It 

is to be noted here that since the conversion is within 

Minna datum, transformation/datum shift parameters 

are not needed. Datum shift parameters are needed 

when transforming between two datums say WGS 84 

and Minna datums. 

 

To convert coordinates from one rectangular 

coordinate system to another, transformation 

/conversion software is used. Consequently, this paper 

presents detailed procedures for the conversion of 

positions from one rectangular coordinate system to 

another using AllTrans and Columbus software. These 

software have been compared with other 

transformation/conversion software and 

recommended for application in Nigeria. The 

comparison of the software is detailed in Eteje et al. 

(2018). For effective application of the two conversion 

software in Edo State as well as the entire country, 

the properties of the Minna datum, the NTM 

projection (the three belts parameters) and those of 

the UTM projection (the three zones parameters) 

must be known. Also, the extent/bound width of each 

belt and zone in each state must be known. This will 

enable the belt and the zone which the positions to 

convert be identified before conversion. Edo State is 

partly west and mid belts, and partly zones 31 and 32. 

 

1.1  AllTrans Software 

According to George (2012), use the AllTrans 

application to perform coordinate transformations 

between various coordinate systems. As mentioned 

above, one can perform conversions between 

coordinates using different mathematical 

representations and geodetic systems. One can 

perform transformations between Gauß-Krüger 

coordinates, UTM coordinates, geographic 

coordinates and 3D-Cartesian coordinates. Manually 

input the data or import it to perform the 

transformation. With AllTrans software, 7-Parameter 

Datum Transformation and calculation of datum 

transformation parameters using identical points can 

be carried out. 

 

1.2 Columbus Software 

Columbus is a one, two, and three dimensional 

network adjustment, network pre-analysis and 

coordinate transformation software package which 

allows one to create, edit, solve and analyse Vertical, 

Geodetic, State Plane, UTM, Custom Projection and 

Local NEE (North, East and Elevation) surveys 

anywhere in the world (Columbus, 2009). Columbus 

accepts terrestrial and/or GPS (satellite) observations 

to define networks. Columbus is not just a network 

adjustment package; it is a complete toolkit which can 

be used for on-the-fly COGO computations, 

coordinate transformations, geoid modelling and 

computation of areas of selected polygons in a project. 

According to Columbus (2009), to report coordinate 

results in a different form, Columbus provides a 

powerful set of coordinate transformation tools to 

generate Geodetic, State Plane, UTM, Custom 

Projection, Earth Centred Earth Fixed Cartesian, or 

Local North, East and Elevation (NEE or NEU) 

positions. To transform geodetic positions from one 

datum to another, Columbus provides rigorous three, 

four and seven parameter least squares datum 

transformation capability. Columbus also includes an 

assortment of Geodetic, State Plane, UTM, Local NEE 
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coordinate geometry (COGO) routines for ad-hoc 

computations, network loop closure and open-ended 

traverses. 

 

1.3 The Nigeria Geodetic Datum 

 

According to Eteje et al. (2018), the Nigeria Minna 

datum is a geodetic datum that is suitable for use in 

Nigeria-onshore and offshore. Minna datum 

references the Clarke 1880 (RGS) ellipsoid (Semi-

major axis, a = 6378249.145m; Flattening, f = 

1/293.465) and the Greenwich prime meridian. The 

datum origin is a fundamental point: Minna base 

station L40. Latitude: 9°38'08.87"N, longitude: 

6°30'58.76"E (of Greenwich). It is a geodetic datum for 

topographic mapping. It was defined by information 

from NIMA (Eteje et al., 2018). Uzodinma et al. (2013) 

gave the orthometric height, H of station L40 as 

281.13m. 

 

1.4 Conversion of NTM and UTM Northing and 

Easting Coordinates to Geodetic Coordinates ( h,, ) 

 

The conversion of the two rectangular systems (NTM 

and UTM) coordinates to geographic positions, 

requires the application of the same models. The 

systems only differ in origin and scale factor. The 

models for the conversion of the NTM and UTM 

coordinates to geodetic or geographic coordinates as 

given by Kiliç, (2005) are: 
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=ok Scale Factor (0.9996 for UTM and 0.99975 for     

NTM) 

x = Easting Coordinate (relative to the Central 

Meridian, CM: (subtract the CM from 

conventional UTM coordinate, x; 500,000mE for 

UTM while it varies for NTM, west belt = 

230738.266mE, mid belt = 670553.984mE and 

east belt = 1110369.702mE).  

y = Northing Coordinate. 

 

1.5 Conversion of the Geodetic Coordinates ( h,, ) 

to Plane Rectangular Systems (NTM and UTM) 

Coordinates 

 

The models for the conversion of geodetic coordinates 

to either of the two local plane rectangular (NTM or 

UTM) coordinates are the same. The differences in 

the two plane systems are in the properties to be used 

in the conversion. Thus, the origin, and scale factor. 

To convert the geographic coordinates (latitude and 

longitude) on the local ellipsoid to either NTM or 

UTM northing and easting, equations (25) to (34) 

given by Manchuk (2009) are used. 

 













−+

+−++−+
=

120/)5872

185(6/)1(

522

3

AeCT

TACTA
NkE o

 

(25) 

















−

++−++

+−++−

=

]720/)330600

5861(24/)49

5(2/[tan

62

242

2

AeC

TTACC

TANMM

kN

o

o



(26) 

















+−

+−++−

+−+

=

720/)1614861(

24/)28134245(

2/)1(1

62

422

2

ATT

AeCCT

AC

kk o (27) 

Where, 

UTMfor9996.0 and NTMfor 99975.0=ok
 (28) 

)1/( 222 eee −= = Second eccentricity squared (29) 

2e = 22 ff −  eccentricity squared   (30) 

=N Radius of curvature as given in equation (2) 

2tan=T      (31) 

22 coseC =     (32) 

 cos)( oA −=
    (33) 

N = Northing of point. 

E = Easting of point. 

= Latitude of point 

= Longitude of point 

=o Longitude of point of center meridian of belt or 

zone. 

 

























++

−++

++

++−

−−−−

=









66

464

26

42

642

sin)3072/35(

sin)1024/45256/15(

sin)1024/45

32/38/3()

256/564/34/1(

e

ee

e

ee

eee

aM (34) 

 

M = Distance on the meridian from parallel of false 

origin (4oN for NTM and 0o for UTM) to the parallel, 

A of point.  

A  = Latitude of the point 

 

According to Manchuk (2009), oM is computed using 

Equation (34) for o , which is the latitude crossing 

the central meridian at the origin of the (E, N) 

coordinates. Equations (1) to (34) are used to develop 

programs which the transformation/conversion 

software normally apply during computation / 

conversion. 

 

1.6 Properties/Characteristics of Nigeria (Modified) 

Transverse Mercator projection (NTM) 

 

The NTM is a modified version of TM adopted for 

Nigeria. The modifications take care of the large 

expanse of the country which covers about l0o (i.e. 

4°N - 14°N) latitude and 12° (i.e. 2° 30° - 14° 30°E) 

longitude. It is generally referred to as 3-belt system 
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(Omoigui, 1973 and Idowu, 2012). The characteristics 

of Nigeria (modified) Transverse Mercator Projection 

(NTM) as given by Uzodinma, et al. (2013) are: 

1. NTM is a conformal projection 

2. The country is divided into 3 belts each 4o  wide 

 (Figure 2). 

3. The 3 belts are bounded in the north by the 

 14oNparallel and in the south by 4oN. Hence the 

 false origin of northing is at latitude 4o N and 

 False Northing, No = 0.000m (see Table 1). 

 

Table 1: NTM Grid Parameters 

Belt Bounding 

Longitudes 

Central 

Meridian 

(lo) 

False Easting 

of Central 

Meridian 

West 2o30’E – 

6o30’E 

4o30’ E 230738.266m

E 

Mid 6o 30’ – 

10o30’E 

8o 30’ E 670553.984m

E 

East 10o30’ –

14o30’E 

12o 30’ E 1110369.702m

E 

Source: Uzodinma, et al (2013) 

 

4. The scale factor at each central meridian is 

0.99975. 

5. A rectangular metric grid is superimposed on the 

three belts such that they intersect along the 9oN 

parallel. 

 

According to Ufuah and Adesina (2005) and Eteje et al. 

(2018), the central meridians of the west and east 

belts are fixed respectively to be 439815.718 metres 

west and east of the central meridian of the mid belt 

along the 9oN parallel. The maximum angular distance 

of a point in a belt, from the central meridian of the 

belt, is 2o. In other words, each belt is 4o wide. 

 

 

 

 

1.7 Properties/Characteristics of Universal Traverse 

Mercator (UTM) as Applied in Nigeria 

Uzodinma et al. (2013) also gave the 

properties/characteristics of the UTM as applied in 

Nigeria as follow: 

1. Nigeria is covered by zones 31, 32 and 33 of the 

UTM. 

2. Each zone has its independent coordinate system 

with X-axis 500,000.0m west of the central 

meridian and Y-axis lying along the equator. 

 

The UTM grid parameters are shown in table 2 as 

given by Uzodinma et al. (2013). 

 

Table 2: UTM Grid Parameters 

Zone 

Bounding 

Longitudes 

Central 

Meridian 

(lo) 

Grid Coord. of 

Central Meridian 

31 0 o- 6oE 3oE 

0.0m N, 

500,000.0mE 

32 6o – 12oE 9oE 

0.0m N, 

500,000.0mE 

33 12o – 18oE 15oE 

0.0m N, 

500,000.0mE 

Source: Uzodinma, et al (2013) 

 

3. UTM in Nigeria is computed on the Clarke 

 1880 reference ellipsoid.  

 

In the UTM, the maximum angular distance of a point 

in a belt, from the central meridian of the zone is 3º 

(Mugnier et al., 2009). Thus, each zone is 6o wide. Its 

application is limited to between latitudes 84oN and 

80oS as stated by Edan et al. (2014). 

 

The properties/parameters of each of the plane 

rectangular systems, NTM and UTM and those of the 

datum in question (Minna datum) are applied during 

the conversion of the coordinates using the software. 

The parameters to apply in each plane rectangular 
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system depend on either the belt or the zone in which 

the positions are. 

 

II. METHODOLOGY 

 

The procedure for the application of the two software 

(AllTrans and Columbus software) for conversion 

between NTM and UTM in Minna datum requires the 

NTM coordinates be converted to geographic 

coordinates using equations (1) and (2), then the 

geographic coordinates are converted to UTM 

coordinates using equations (25) and (26). The same 

procedure is used when converting UTM coordinates 

to NTM positions (see figure 1). 

 

2.1 Procedure for Application of AllTrans Software 

for Coordinates Conversion between NTM and UTM 

The following steps are considered when converting 

positions from NTM to UTM: 

1. Launch the software, displays as shown in Figure 2. 

2. In Start Coordinate System, drop-down Area and 

select Nigeria. This will automatically display Minna 

(Clarke 1880 (RGS)) in the Geod Datum. 

 

 

 

Fig. 1: Conversion between NTM and UTM Coordinates 

 
Fig. 2: Launched AllTrans Software 

2.2 Procedure for Application of AllTrans Software 

for Coordinates Conversion between NTM and UTM 

The following steps are considered when converting 

positions from NTM to UTM: 

1. Launch the software, displays as shown in Figure 2. 

2. In Start Coordinate System, drop-down Area and 

select Nigeria. This will automatically display Minna 

(Clarke 1880 (RGS)) in the Geod Datum. 

3. Check Projection and select either west, mid or 

east belt, depending on the belt in which the positions 

to convert are. 

GEOGRAPHIC 

COORDINATES 

 

NTM 

COORDINATES 

 

UTM 

COORDINATES 
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4. In Target Coordinate System, drop-down Area and 

select Nigeria. This will also automatically display 

Minna (Clarke 1880 (RGS)) in the Geod Datum.  

5. Check UTM and select either zone 31, 32 or 33, 

also depending on the zone in which the positions to 

convert are. 

6. In Plane Coordinate, input the control ID and 

coordinates (northing and easting) accordingly one 

after the other. 

7. Finally, click on Start Calculation at the bottom 

right-hand side of the software environment to 

convert and display the converted UTM coordinates. 

Note that at this step, the coordinates of a point are 

converted one after the other. 

 
Fig. 2: Launched AllTrans Software 

8. If the coordinates are many and they are to be 

converted at the same time, click the Parameter menu 

then, the Format of Data submenu to select State 

System. This will display the Start System Data 

Format dialog box. In the dialog box, click on Plan 

Coord tab and check/select data format of interest say 

Name, North, East and Height and click OK (see 

Figure 3). 

East and Height and click OK (see Figure 3). 
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Fig. 3: Setting of Start Coordinate System Data Format 

9. Also, set the Target Coordinate System Data 

Format. Click the Parameter menu then, the Format 

of Data submenu to select Target System. This will 

display the Target System Data Format dialog box. In 

the dialog box, click on UTM tab and check/select 

data format of interest say Name, North, East and 

Height and click OK (see Figure 4). Note that the Start 

and the Target Coordinate System data format must 

be the same. 

 
Fig. 4: Setting of Target Coordinate System Data Format 
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10. Type the input coordinates (NTM) in notepad in 

the order of the chosen data format and save the file 

on either Desktop or in Document. 

11. Click on the File menu and select Open File (File 

Input) submenu. Navigate to where the saved input 

file is and import the NTM coordinates to the 

software environment. 

12. Click on Start Calculation at the bottom left-

hand side of the software to convert the NTM 

coordinates in the imported file. 

13. Click on View File at the bottom right-hand side 

of the software to display the converted UTM 

coordinates. 

14. Also, click on View File at the bottom left-hand 

side of the software to display the inputted NTM 

coordinates (See Figure 5). 

 
Fig. 5: Inputted NTM and Converted UTM Coordinates 

To convert from UTM to MTN, the same procedure is 

used except for the following: 

1. In step 3, the Start Coordinate System will be set to 

UTM and either zone 31, 32 or 33 will be selected, 

depending on the zone in which the UTM coordinates 

to convert are. 

2. In step 5, check Projection and select either west, 

mid or east belt, depending on the belt in which the 

positions to convert are. 

3. In step 6, in UTM Coordinate, input the control 

number and the UTM coordinates (northing and 

easting) accordingly one after the other. 

4. In step 6, click on Start Calculation to convert and 

display the converted NTM coordinates at the bottom 

right-hand side of the software environment. 

5. In steps 8 and 9, set the Start (input) and the 

Target (output) Coordinate Systems data formats to 

UTM and NTM respectively. And they must be the 

same. 
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6. In step 12, also click on Start Calculation at the 

bottom left-hand side of the software to convert the 

UTM coordinates in the imported file. 

7. In steps 13 and 14, click on View at the bottom 

right and left-hand sides to respectively display the 

converted NTM and the inputted UTM coordinates. 

2.3  Procedure for Application of Columbus Software 

for Coordinates Conversion between NTM and UTM 

The conversion of coordinates between two 

rectangular systems using Columbus software, 

requires the rectangular coordinates be converted to 

geographic positions then, the geographic positions 

are re-entered into the software and converted to 

rectangular coordinates of interest. Columbus is not 

like AllTrans software that does the conversion 

directly. The following steps are considered when 

converting positions from NTM to UTM: 

1. Launch the software.  

2. Click on the File menu to select New as shown in 

Figure 6. This will display a new working 

environment. 

 
Fig. 6: Creating New Working Environment 

3. Click on Options menu to select Datum submenu. 

This will display Select a Datum dialog box. In the 

dialog box, select Clarke 1880 and click OK (see 

Figure 7). 

 
Fig. 7: Selection of Datum (Ellipsoid) 

4. Also, click on the Options menu to select Unit 

submenu. This will display Linear and Angular Units 

dialog box. In the dialog box, check Metres in Linear 

Units, Degrees in Angular Units and DD.MMSSsssss 

(Degree Minute and Second) in DMS or GMS Input 

and click OK (see Figure 8). 
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Fig. 8: Linear and Angular Units Settings 

5. To set/enter the NTM belt parameters in which the 

positions to convert are, click on Options menu to 

select Projection submenu. In the Projection submenu, 

select State Plane Zones to display Select/Setup The 

Current Projection Zone dialog box. In the dialog box, 

select User Define (UD Traverse Mercator, TM) (see 

Figure 9) and click OK to display Setup Traverse 

Mercator Projection dialog box. In the dialog box, 

enter the belt parameters in which the coordinates to 

convert are. Enter the following parameters for the 

Nigeria West belt given in the first row of Table 1 as 

shown in Figure 10. 

 
Fig. 9: Selection of Current Traverse Mercator Belt 

 
Fig. 10: Entering of the Positions Belt Parameters (Nigeria West Belt Parameters) 
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6. To set/enter the UTM zone parameters in which 

the positions to convert are, click on Options menu to 

select Projection submenu. In the Projection submenu, 

select UTM Zone Setup to display UTM or TM Zone 

Setup dialog box. In the dialog box, select the zone in 

which the coordinates to convert are and click OK. 

Here, zone 31 is selected as shown in Figure 11. Note 

that the selection of a zone will automatically update 

the other fields of the dialog box. 

 

 
Fig. 11: Entering of the Positions Zone Parameters (Zone 31 Parameters) 

7. Having done with the necessary settings, click on 

the Data menu and select Stations submenu to display 

Add or Modify Station Data dialog box. In the dialog 

box, click on State Plane to enter the NTM 

coordinates. Also, click on Add 25 Rows at the top 

right-hand side of the dialog box to display the 

spreadsheet in which the positions information will 

be entered. Enter the stations' IDs/Numbers, Northing 

and Easting coordinates of the points and click Keep 

and Exit tab at the bottom left-hand side of the dialog 

box (see Figure 12). This will exit the dialog box and 

plot the points/stations in the software environment 

(see Figure 13). 

 
Fig. 12: Entering of the NTM Coordinates 
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Fig. 13: Plotted UTM Points in the Software Environment 

8. To convert the NTM coordinates to geodetic 

positions, click on the Tools menu to select 

Transformation submenu. In the Transformation 

submenu, select State Plane to Geodetic to display 

State Plane to Geodetic Zone UD Traverse Mercator 

dialog box. In the dialog box, click on Compute at the 

bottom left hand side to display Select Station to 

Transform dialog box. In the displayed dialog box, 

click Select All at the middle right-hand side and click 

OK at the top right-hand side (see Figure 14). The 

converted geodetic coordinates are displayed in the 

State Plane to Geodetic Zone: UD Traverse Mercator 

dialog box. Also, see Figure 15. 

 

 
Fig. 14: Selected Points/Stations 
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Fig. 15: Converted Geodetic Coordinates 

9. To report the converted geographic coordinates, 

click on Report at the bottom left-hand side of the 

State Plane to Geodetic Zone: UD Traverse Mercator 

dialog box to save the converted 

coordinates/processing report on either Desktop or in 

the Documents folder. The processing report is given 

in both Excel and Notepad. Figure 16 shows the 

Notepad processing report. 

 
Fig. 16: Processing Report for Converted Geodetic Coordinates in Notepad 

 

10. Having converted the NTM coordinates to 

geographic positions then, repeat step 7 to enter the 

converted geodetic coordinates in the Geodetic tab of 

the Add or Modify Station Data dialog box.  

 

 

11.  Repeat step 8 to convert the geodetic coordinates 

to UTM positions. In the Transformation submenu, 

select Geodetic to UTM. 

12.  Also, repeat step 9 to report the converted UTM 

coordinates (see Figure 17). 
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Fig. 17: Processing Report for Converted UTM Coordinates in Notepad 

 

To convert from UTM to NTM with Columbus 

software, the same procedure is used except for the 

following: 

1. In step 7, enter the UTM coordinates in the Add 

or Modify Station Data dialog box. 

2. In step 8, select UTM to Geodetic in the 

Transformation submenu. 

3. Having converted the UTM coordinates to 

geodetic positions, repeat step 7 to enter the 

converted geodetic coordinates in the Geodetic 

tab of the Add or Modify Station Data dialog box.  

4. Repeat step 8 to convert the geographic 

coordinates to NTM positions. 

5. Also, repeat step 9 to report the converted NTM 

coordinates. 

 

III. CONCLUSIONS AND RECOMMENDATIONS 

 

Having given detailed procedures for the use of 

AllTrans and Columbus software for the conversion 

of coordinates between NTM and UTM systems, the 

following conclusions and recommendations were 

made: 

 

1. For effective application of the two software, 

considering the enumerated steps to be 

considered, the belt, as well as the zone in which 

the positions to convert are must be identified 

before the conversion process. This will enable 

the right, as well as the correct belt and zone 

parameters, be entered in the software. 

2. The Minna datum, as well as Clarke 1880 

ellipsoid parameters, should be correctly inputted 

into the software as the conversion is within 

Minna datum only. Thus, the Clarke 1880 

ellipsoid is common to both coordinate systems in 

this regard. 

3. The Edo State branch of the institution (NIS) 

should get the full and the latest version of the 

software. 

4. There should also be a lecture for the practical 

demonstration of the detailed procedures. 
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